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Emulation 

UTS eXpress IT Control Panel 

The UTS eXpress IT Control Panel initially appears when the UTS eXpress IT program/icon is 
executed from the UTS eXpress IT folder.  The control panel contains a series of functions that permit 
you to establish emulation sessions with the host and control the disposition of the control panel.  
Additionally, a configuration command is available allowing font and color selection, configurable UTS 
keys, screen size selection, route selection and other standard UTS controls. 

 

  
 

Left Mouse Click 

A left mouse click on the following button controls allows you to establish host connections, to 
configure UTS eXpress IT, etc.:  

Screen Buttons 

Press any of the grayed numbered buttons to open a dialog with the host. 

Initially, the maximum number of screens that may be configured is six.  This number may be 
increased to 24 (see UTS eXpress IT Configuration). 

Minimize All 

Press this button to minimize the UTS eXpress IT Control Panel and all active screens. 

Configure 

Press this button to initiate the UTS eXpress IT Configuration dialog where the appearance 
and behavior of UTS eXpress IT may be changed. 

Help 

Press this button to receiv  help for the UTS eXpress IT Control Panel. 

Exit 

Press this button to close all screens currently opened and terminate UTS eXpress IT. 

Right Mouse Click 

A right mouse click anywhere within the control panel will present a menu that allows you to control 
sessions, to position the control panel, etc.: 

Open Screens 

Move the mouse cursor over this selection to view a menu of configured screens.  Only the 
screens not currently opened will be enabled for selection. 

Close Screens 

Move the mouse cursor over this selection to view a menu of configured screens.  Only the 
screens currently opened will be enabled for selection. 

Close All 

Left mouse click this selection to close all screens currently opened and terminate UTS eXpress 
IT. 

Minimize All 

Left mouse click this selection to minimize the UTS eXpress IT Control Panel and all active 
screens. 

Keep On Top 

Select this option to keep the control panel on top of any other windows displayed. 
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Auto Hide 

When the control panel is docked to an edge of the desktop, selecting this option will cause the 
control panel to hide when the mouse cursor is away from the edge. 

Note: To dock the control panel, drag and drop the control panel with the mouse to any edge 
(left, right, top or bottom) of the desktop display. 

Transport Trace 

Use this selection to create a diagnostic trace at the transport level.  This selection should only 
be used if requested by KMSystems support personnel. 

UTS eXpress IT Screen 

The UTS eXpress IT window contains all the necessary Windows controls to manage a host 
connection.  Controls are available to control the size of the font displayed and the spacing between 
lines.  There are also controls to perform print functions, recall previously entered input, execute user-
developed scripts, etc. 

When multiple screens are open, you may use the Esc key to switch between non-minimized screens.  
Likewise, the Next Screen selection from the Window menu will switch between non-minimized 
screens 

The following is an explanation of each menu selection or control.  When shortcut keys are available, 
the key combination (e.g., Ctrl+L) is shown to the right of the menu selection. 

File menu 

The File menu contains controls to configure the appearance and behavior of UTS eXpress IT and to 
manage the print environment of UTS eXpress IT. 

Print Screen (All)  Ctrl+P 

Use this selection to print an exact image of the entire screen. 

Print Screen (UTS)   Ctrl+U 

Use this selection to produce the traditional UTS "Print Screen" operation.  The selection prints 
all the text from the previous SOE to the current cursor position. 

Close Print   Ctrl+L 

Use this selection to end the print operation.  This selection only appears on the menu as a 
result of issuing a Print Screen command. 

Printer Assignment… 

Use this selection to assign up to three printers for the screen. 

Print Window Image 

Use this selection to print the entire window including the screen and the Windows controls 
surrounding the screen. 

Capture Screen   Alt+Shift+Backspace 

Use this selection to capture the currently selected screen. 

Print Captured Screens 

Use this selection to print any captured screens. 

Save Captured Screens 

Use this selection to save any captured screens to a text file. 

Clear Captured Screens 

Use this selection to clear the captured screen stack. 

Send To… 

Use this button to send a copy of the screen through your mail system. 

Diagnostics 

Trace to Window 

Use this selection to initiate the UTS eXpress IT trace facility.  All communications 
between UTS eXpress IT and the host will be displayed in a separate window. 
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Note:  A right mouse click in the trace window will reveal a menu containing three 
selections that control the trace window: Stay on Top, Copy to Clipboard and Clear.  
Stay on Top controls whether the trace window remains on top (the default) of the 
emulator window during the trace, or remains in the background.  Copy to Clipboard 
may be used to copy the contents of the trace window to the Windows clipboard for 
subsequent pasting into another Windows application (e.g., Notepad, WordPad, etc.).  
Clear may be used to clear the contents of the trace window. 

Trace to File 

Use this selection to initiate the UTS eXpress IT trace facility.  This selection is the 
same as Trace to Window except that the trace information will be written to a user-
named file. 

Trace to Both Window and File 

Use this selection to initiate the UTS eXpress IT trace facility.  This selection is a 
combination of the two above. 

Clear Trace Window 

Use this selection to clear the trace window and/or file without terminating the trace.  
This selection appears after a trace has been initiated. 

Close Trace 

Use this selection to close the trace window and/or file and terminate the trace. 

FCC Map to Trace 

Use this selection to display an FCC Map.  Use only at the request of KMSystems 
support personnel. 

Control Page 

Use this selection to display the contents of the UTS Control Page in the trace window 
and/or file. 

Note:  The previous four selections only become visible once the trace has been started. 

Customize 

Use this selection to customize the appearance and functionality of this screen.  Note: All of 
these settings may also be changed from the configuration program. 

Custom Keyboard Layout 

Use this selection to modify a keyboard configuration.  The initial configuration shown 
will be for the keyboard assigned to this screen. 

Select Keyboard Layout 

Use this selection to assign a preconfigured keyboard to this screen. 

Screen Appearance 

Use this selection to modify a screen appearance scheme.  The initial configuration 
shown will be for the scheme assigned to this screen. 

Select Screen Appearance 

Use this selection to assign a preconfigured screen appearance to this screen. 

Close 

Use this selection to break the host connection and terminate this UTS eXpress IT window. 

Edit menu 

The Edit menu contains controls to manage selected text between the screen and the Windows 
clipboard. 

Copy   Ctrl+C 

Use this selection to copy selected data onto the clipboard.  This command is unavailable if there 
is no data currently selected.  Note: Copying data to the clipboard replaces the contents 
previously stored there. 
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Data may be selected by placing the mouse cursor at some point on the screen, and holding 
down the left mouse button, drag the mouse cursor to any other location on the screen.  Upon 
releasing the left mouse button, the data will be selected. 

An alternate form of selection is with standard, keyboard key sequences.  With the mouse or 
arrow keys, place the screen text cursor at some point on the screen and use any of the 
following key sequences to highlight the data being selected: 

Shift+Home selects everything from the cursor position through column one of the 
same row. 

Shift+End selects everything from the cursor position through the last column of the 
same row. 

Shift+Right Arrow extends/contracts the selection to the right. 

Shift+Down Arrow extends/contracts the selection down the screen. 

Shift+Left Arrow extends/contracts the selection to the left. 

Shift+UP Arrow extends/contracts the selection up the screen. 

Cut   Ctrl+X 

Use this selection to remove the currently selected data from the document and put it on the 
clipboard.  This command is unavailable if there is no data currently selected. 

Cutting data to the clipboard replaces the contents previously stored there. 

Paste   Ctrl+V 

Use this selection to insert a copy of the clipboard contents at the insertion point.  This 
command is unavailable if the clipboard is empty. 

Note:  Use a right mouse click, anywhere on the screen, to reveal a Copy/Cut/Paste popup menu. 

Input Recall   Ctrl+Up 

Use this selection to initiate the Input Recall window.  This selection allows previous lines 
transmitted to the host to be recalled and retransmitted. 

Block Selection 

Rectangle Block Selection 

Set this option (the default) when you want the mouse drag-and-drop action to select 
a rectangular block of screen positions.  This option is useful when cutting and pasting 
to line number oriented editors such as over existing lines in a full screen editor (e.g., 
Q/Editor Plus, IPF, etc.). 

Linear Block Selection 

Set this option when you want the mouse drag-and-drop action to select a linear group 
of lines.  This option is useful when cutting and pasting between the screen and non-
line number oriented processors (Word, WordPad, NotePad, etc.). 

Edit Control Page 

Use this selection to edit the UTS Control Page. 

Change Route Settings 

Use this selection to change dynamically route settings configured for the currently selected 
screen.  Any setting may be changed except the route name, number of rows and columns.  
This function is most useful when there is a need to switch to alternate TIP systems without 
having to configure separate routes in order to supply unique Station Name requirements.  Any 
changes made through this function are only in effect while the screen remains open.  Upon 
reopening the screen, the route settings originally associated with the screen, through the UTS 
eXpress IT configuration function, will be used. 

View menu 

The View menu contains controls that adjust the appearance and functional state of UTS eXpress IT. 

Show Keyboard Help Window...   Alt+K 

Use this selection to display the Keyboard Help window. 
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Show Inactive Page 

Use this control to toggle the inactive screen page display.  When checked along with the 
screen paging feature enabled, the last screen page will be shown in an inactive screen page 
window located in the lower half of the screen window.  This feature allows you to view the 
results of a transaction or program in an inactive, read-only, pane of the window while 
executing another transaction in the active portion of the window.  The inactive pane is always 
shown in black on white.   

If there is more than one active screen page configured, clicking the gray separator bar causes 
the inactive screen page display to scroll to the next inactive screen page (notice that the 
current active page is never shown in the inactive pane). 

When using this option, the screen window may have to be resized manually to accommodate 
the dual screen display. 

Note: The inactive page will not appear until the user does the first Page Down or Page Up. 

WARNING:  The host is completely unaware of the paging feature.  Applications, especially DPS, 
often check the screen input for specific content; meaning the application, knowing that a 
certain screen was displayed, expects the returned data to come from that screen.  Use of the 
Page Down and Page Up keys with this feature can leave the screen in a state not expected by 
the application. 

Show Mouse Tracking 

Use this selection to toggle between displaying the mouse pointer's row and column and the 
text cursor's row and column.  The display appears on the left side of the status bar at the 
bottom of the screen.  This feature allows the user to determine row and column coordinates of 
protected fields, which can be handy for scriptwriters. 

Show Reference Grid 

Use this selection to toggle the display of a reference grid over the screen.  The grid is useful 
when developing scripts.  The reference grid makes it easy to find column/row coordinates 
while a script dialog is displayed.  You cannot use mouse tracking once a script dialog is up, but 
you can see and count lines and columns on the reference grid. 

Show Control Characters 

Use this selection to toggle the display of control characters (Tab, Form-Feed, Line-Feed, etc.).  
Checking the Mapper Look box on the Terminal Settings tab (see UTS eXpress IT 
Configuration) disables the display of control codes (even though the control character display 
is enabled).  The only exceptions are the Tab and MAPPER Tab characters. 

Macros menu 

The Macros menu is used to control the key macro recorder and to provide access to macros placed 
for selection on the menu. 

Macros 

Use this selection to drop down a list of user-created key macros. 

Use the Macro Manager selection (see the Other Settings tab after clicking the Configure 
UTS eXpress IT button on the UTS eXpress IT Control Panel) to develop and maintain 
macros and the Macros menu. 

Start Macro Recorder 

Use this selection to begin the Key Macro Recording (Note: A recorder icon will appear in the 
status line at the bottom of the window signifying that the recorder is active).  All keystrokes 
entered will be collected until the recording is terminated with the Stop Macro Recorder 
selection. 

Stop Recorder 

Use this selection to terminate the macro recorder.  Upon making this selection, the Save Key 
Macro dialog will allow the macro to be named and saved. 

FCCs menu 

The FCCs menu contains selections for manually generating, locating, clearing and enabling Field 
Control Characters (FCCs) on the screen. 
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FCC Locate   Ctrl+Alt+F 

Use this selection to locate the next FCC position on the screen. 

FCC Generate   Ctrl+Alt+G 

Use this selection to generate a new FCC at the current, text cursor position.  This selection 
may also be used to examine or change an existing FCC (use after the FCC Locate command, 
below). 

FCC Clear   Ctrl+Alt+C 

Use this selection to clear the FCC at the current, text cursor position. 

FCC Enable   Ctrl+Alt+E 

Use this selection to enable FCC emulation once FCCs have been manually placed (generated) 
on the screen. 

Window menu 

The Window menu contains a selection controlling the UTS eXpress IT window size in relationship to 
the font size. 

Resize Screen to Font 

Use this selection to resize the UTS eXpress IT window to conform to the selected font size. 

Hide Control Panel/Show Control Panel 

This toggle hides or displays the UTS eXpress IT Control Panel.  Note: If all screens are closed 
while the Control Panel is hidden, the Control Panel will be automatically displayed.  This menu 
item is disabled if the NCP (No Control Panel) command line parameter is used. 

Next Screen   Esc 

Use this selection to switch between non-minimized screens. 

Previous Screen   Shift+Esc 

Use this selection to switch to the previous non-minimized window. 

Help menu 

The Help menu contains selections that provide complete on-line help and UTS keyboard assistance. 

Contents 

Use this selection to run Windows Help for UTS eXpress IT and display the Contents topic.  All 
on-line help may be reached from this topic. 

This Window 

Use this selection to run Windows Help for UTS eXpress IT and display this topic. 

About 

Use this selection to display version and copyright  about UTS eXpress IT.  

Input Recall window 

UTS eXpress IT saves single-line messages sent to the host system when you press the transmit key.  
A maximum of 200 of the most recent messages is saved.  You can display a list of these messages 
from the Edit, Input Recall menu selection, or by pressing the Input Recall key (Ctrl+Up Arrow). 

Paste 

When this list is displayed in the Input Recall window, you can view the entries and optionally 
select an entry to be "pasted" onto the current screen when the Paste button is pressed. 

Transmit 

The Transmit button performs the same operation as the Paste button, but also ends by 
transmitting to the host (double clicking on the entry also performs the paste-and-transmit 
operation). 

Remove All 

Use this selection to empty the recall list. 
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Close  

Use this button to close the Input Recall window. 

 UTS eXpress IT Keyboard Definition window 

This window displays all the standard UTS keys and their corresponding keyboard keystrokes.  Any UTS 
key may be issued by double-clicking the left mouse button over the UTS key name.  Additionally, the 
window may remain open as a visual reference when entering UTS key sequences from the keyboard. 

Stay on Top 

Check this box to force the window to remain visible while working on an emulator screen. 

Keep Active on Show 

Check this box to keep focus on the UTS eXpress IT Keyboard Definition window when the 
window first comes up.  When not checked, focus will immediately return to the main emulator 
window. 

Close 

Use this button to close the UTS eXpress IT Keyboard Definition window. 

Screen Printer Device Assignments 

Use the Screen Printer Device Assignments window to assign a locally defined printer to one of 
three screen DIDs. 

 

  

 

Printer Device 1 through Printer Device 3 (DID1 through DID3) 

The controls in this group allow you to attach local printer definitions to one of three screen DIDs.  The 
three DIDs correspond to the AUX DIDs configured for the route chosen for the screen.  You configure 
the route by pressing the Configure button on the Terminal Settings tab. 

Select 

Use this button to initiate the Terminal Printer Setup dialog.  With this selection, you may 
assign a previously configured local printer or create a new printer definition from all printers 
installed on your PC. 

Clear 

Use this button to detach the local printer definition from the DID. 
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OK 

Clicking the OK button saves all changes made in this window and closes the window. 

Cancel 

Clicking the Cancel button closes this window and discards all changes made since it was last opened. 

Help 

Receive on-line help for this window. 

Send To ... 

Use this dialog to select the Send option desired. 

Send Contents of Screen as Text 

Set this option to capture the contents of the screen as text.  When the OK button is pressed, the text 
will appear in the message portion of the compose dialog displayed by your mail system. 

Send Screen Window as JPEG Attachment 

Set this option to capture the contents of the screen as a JPEG image.  When the OK button is pressed, 
the image will be inserted as an attachment to your mail message. 

UTS Control Page 

This dialog may be used to edit the UTS Control Page and for performing control page file transfers. 

Note: Only the controls that may be set from the PC are enabled (see below): 
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XMIT 

UTS emulation provides three modes of transferring data from the terminal screen to the host 
processor: VAR (Variable), ALL, and CHAN (Changed).  The current transmission mode is set in the 
XMIT() field in the terminal control page.  Most host programs expect the terminal to be operated in 
the VAR transmit mode. 

Send 

Set this option to upload a PC file to the host.  Upon pressing the OK button, the send action will begin. 

Drive 

In this text box, enter the drive containing the file to be uploaded. 

File 

In this text box, enter the PC file name to be sent to the host. 

Extension 

In this text box, enter the PC file extension. 

Options 

In this text box, enter the send options.  Valid options are: 

B TCS block format (used by MAPPER file transfer run, QSQTXFR). 

C Clear screen before creating send data block. 

L Limit send data block to 23 lines. 

M Menu-fill mode using tabs to position cursor. 

P Paint send data screen beginning at cursor location. 

R Transmit carriage-returns in data stream to host. 

S Send data in "stream mode". 

Tx Tab codes are replaced with the value of "x".  The value of "x" must be a non-numeric 
character. 

Tn Tab codes are expanded to "n"-wide column boundaries.  The value of "n" must be a 
numeric digit. 

X Binary (hexadecimal) file transfer format. 

Sep Chr (Hex) 

Used to separate images, for example, enter "0A" for a Line Feed. 

Prompt (Hex) 

Normally UTS SOE, enter "1E" (ASCII code for SOE). 

Blk. Size 

Sets maximum data block size sent to host.  May not exceed the screen character size (rows * 
columns). 

Example: 

Bring up the control page, enter the following, and press the OK button:. 

C SENDFILE TXT  1E 80 

 

On the host, use  

@elt,il pf.sendtest                                   

ELT     8R2I (940207 1418:00) 1998 May 28 Thu 1546:02 

 

Recv 

Set this option to download a host file to the PC.  Upon pressing the OK button, the receive action will 
begin. 
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Drive 

In this text box, enter the drive to receive the downloaded file. 

File 

In this text box, enter the PC file name to receive the host file. 

Extension 

In this text box, enter the PC file extension. 

Options 

In this text box, enter the receive options.  Valid options are: 

A Acknowledge host after each block. 

B Remove trailing blanks from received images. 

C Exclude final cursor position from captured received data. 

D Delete EOF sentinel from received data. 

E Transfer data from SOE to end of screen to output file. 

F Preserve form feed characters in the received data. 

I Insert a "new line" sequence after each received screen of data. 

N Do not write null (empty) records to the output file. 

P Suppress transfer to printer. 

R Write raw receive data to file (supports DEMAND @@BLCK use). 

Tx Tab codes are replaced with the value of "x".  The value of "x" must be a non-numeric 
character. 

Tn Replace multiple spaces with tab codes at column "n" boundaries.  The value of "n" must 
be a numeric digit. 

W Delete EOF sentinel from received data (just like "D"). 

X Binary (hexadecimal) file transfer mode. 

Y Inhibit national language, special character translations. 

Sep Chr (Hex) 

Used to separate images, for example, enter "0A" for a Line Feed. 

EOF 

0-16-character string signaling the end of the data transfer (not case sensitive), also see the 
D/W options. 

Example: 

On the host, edit the file 

@ed,r mydatafile.                                    

READ-ONLY MODE                                 

ED 16R1E THU-05/28/98-13:40:31-(0,)            

EDIT                                           

0:  

 

Bring up the control page, enter the following, and press the OK button:. 

C RECVFILE TXT SWI 0A EOF 

 

On the host, enter: 

0: p! 
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Send Path 

In this text box, enter the path (no drive or file name) to the send file.  Entering a path here overrides 
the file transfer defaults set in the UTS eXpress IT configuration. 

Recv. Path 

In this text box, enter the path (no drive or file name) to the receive file.  Entering a path here 
overrides the file transfer defaults set in the UTS eXpress IT configuration. 

OK 

Click this button to accept any changes made in this window and close the window. 

Cancel 

Click this button to discard any changes made and close the window. 

Help 

Receive on help for this window. 

FCC Generate 

Field Control Characters (FCCs) are defined by Unisys and are used to control the function and 

appearance of areas of the UTS format screen displayed by UTS eXpress IT.  You can use the FCC 
Generate window to examine (and possibly create or change) the characteristics associated with a 
field on the current UTS screen.  You should probably not modify the FCC characteristics set by your 
application unless you are responsible for programming that application.  Modifying the FCC 
characteristics of a UTS screen field could cause your application to malfunction. 

The FCC Generate window displays the characteristics of the current (cursor position) FCC field by 
setting the appropriate option.  For example, a hidden field will have the Video Off box checked.  Both 
the compatible and expanded (newer) representation of the UTS FCC is displayed.  See the Unisys 
manual, "Uniscope Protocol Reference", UP-10683 (current revision) for a complete definition of these 
parameters.  In addition, your application (e.g., DPS) programming reference will typically provide 
information on the proper use of FCC field characteristics. 
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FCC Settings 

The FCC Settings affect the character at the current, text cursor position and all characters up to the 
next FCC. 

Video Off 

This option is set if characters have no intensity.  The cursor moves but characters do not 
appear on the screen.  If this box is checked, the Low Intensity, Reverse Video and Blink 
options are disabled. 

Low Intensity 

This option is set if characters are to appear in half the intensity of normal characters. 

Reverse Video 

This option is set if the background and foreground are reversed.  The foreground color (if any) 
becomes the background color and visa versa. 

Blink 

This option is set if the characters are to blink. 

Tab Stop 

This option is set if the character is a tab stop position. 

Emphasis Protect 

This option is set if the character is a special emphasis character (column separator, 
underscore, strikethrough or a character from a loadable character set) and is protected. 

Data Protected 

This option is set if the characters are protected from data entry by the user.  If this box is 
checked, Right Justify and Data Entry controls are disabled. 

Right Justify 

This option is set if the characters are to be entered from the right side of the field and shifted 
left as each character is entered. 

Data Entry 

These mutually exclusive option buttons are set if the data being entered is Any character, 
Alpha only or Numeric only. 

OK 

Click this button to accept any changes made in this window and close the window. 

Cancel 

Click this button to discard any changes made and close the window. 

Help 

Receive on help for this window. 

UTS eXpress IT Graphics Viewer 

This dialog is displayed by pressing the F1 key from a MAPPER results RID containing graphics 
primitives received from the host or when the UTS eXpress IT Graphics Viewer is run stand-alone from 
the icon. 

File menu 

Open Graphics Script… 

Use this selection to open a file (.grs) containing previously saved graphics primitives. 

Save as… 

Use the selection to save the graphics primitives to a file. 

Copy to Clipboard as BMP 

Use this selection to copy the chart to the Windows clipboard as a bitmap (.bmp). 
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Print… 

Use this selection to initiate the Windows Print dialog for printing. 

Close 

Use this option to close the dialog. 

Options menu 

Maintain Aspect Ratio 

Check this selection to maintain the height and width of the graph in such a manner that they 
stay in proportion to one another, regardless of how the Graphics Viewer window is resized. 

View Graphics Commands 

Use this selection to initiate the Graphics Command Viewer dialog where the graphics 
commands that were used to produce the chart may be viewed and/or printed. 

Redraw 

Use this selection to redraw the chart. 

Window menu 

Show Screen Window 

Use this selection to switch back to the original screen window used to initiate the chart. 
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Configuration 

UTS eXpress IT Configuration 

The UTS eXpress IT Configuration dialog contains configuration options that assign the 
communication route to be used when the screen is opened.  The dialog is also used to assign printers 
to screens and set general screen appearance options.  Each screen may also have its own tool bar, 
keyboard and script menu assigned.  In addition, a sign-on script may be assigned to each screen to 
facilitate connecting to the host. 

 

  

 

Screen tabs 

Select the screen tab you wish to configure.  If you need more than two (2) screens, please visit the 
KMSystems web site (www.kmsys.com) and look for our UTS eXpress Plus product that allows up 
to 24 screens. 

Terminal Settings tab 

The controls in this group link a screen to a particular route and set screen options.  . 

Connection Route 

From this drop-down list box, select a configured route to be used when the screen is opened.  
If additional routes are required, use the Configure button on any screen tab. 

Open Screen on Start Up 

Check this box to connect automatically to the route when UTS eXpress IT is first started. 

http://www.kmsys.com/
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Reopen on Host Close 

Check this box to automatically attempt to re-establish the session whenever it has been closed 
by the host. 

Enable Input Recall 

Check this box to maintain a list of recent input for the opened screen.  This feature is enabled 
by default. 

Initial Transmit Type 

UTS emulation provides three modes of transferring data from the terminal screen to the host 
processor: VAR (Variable), ALL, and CHAN (Changed).  The current transmission mode is 
set in the XMIT() field in the terminal control page.  Most host programs expect the terminal to 
be operated in the VAR transmit mode.  If your application requires an initial mode other than 
VAR, set it here and UTS eXpress IT will initialize the XMIT() field with that value.  

Trace on Start Options 

The controls in this group determine what trace activity is to take place, if any, when the screen 
is first opened. 

None 

When this option is set, no tracing activity will take place. 

To Window 

When this option is chosen, a separate trace window will open to display the trace. 

To File 

This option will cause the Emulator TraceFile dialog to open when the screen is 
opened.  In this dialog, enter the text file name for the trace file.  The trace file is 
normally stored in C:\Documents and Settings\<username>\Local Settings\Temp 
directory and will have a .txt extension.. 

To Both 

Select this option to trace to a window and file. 

Screen Options 

The controls on this tab govern general screen appearance. 

Force UPPERCASE Only 

Checking this box causes UTS eXpress IT to translate lower case characters that are 
typed to their uppercase equivalents. 

Blinking Cursor 

Checking this box causes the current cursor position to blink.  If this box is not ch the 
cursor remains solid. 

Real Blinking 

Uncheck this box to suppress blinking of the UTS blinking character.  The blinking 
character is used in some applications to designate special conditions.  For example, in 
IPF, the blinking character at the end of a display line signifies that there is additional 
information beyond the blinking character that cannot be displayed.  The blinking 
default is blinking. 

Text-only Blink 

Check this box to blink only the text of the UTS blinking character instead of the text 
and background.  The Real Blinking checkbox must be checked for this option to 
work. 

 Mapper Look 

Check this box to set UTS eXpress IT for "Mapper Look and Feel" processing.  With 
Mapper Look checked, four of the display characteristics of UTS eXpress IT change: 

1) If a line contains an ASCII Tab Code in the first column, that line is considered 
a "Tab Line".  Tab codes are displayed using the graphic vertical bar (|) that 
produces a visual column separator for your report. 
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2) The only control characters displayed will be the Start-of-Entry (SOE), the 
standard Tab Code, and the Mapper Tab Code.  Characters such as Form-Feed 
and Line-Feed are displayed as spaces. 

3) A protected field (function key name on the last row of the Mapper screen) 
can be transmitted by clicking with the mouse.  This is compatible with the 
function key lines produced by Mapper 2200 level 35. 

4) UTS eXpress IT will also support special Mapper box drawing sequences sent 
from the host. 

 Note: When Mapper Look is used, the Mapper station must be configured as a 
terminal type of "PCE" with an option of "S" (Mapper Look and Feel), or as a 
terminal type of "6S". 

Beep Sound 

Checking this box turns audible message wait beep on.  If this box is not checked, no 
audible sound will be heard. 

Screen Pages 

In this text box, you may specify from one (default) to nine screen pages for each UTS 
screen.  In conjunction with the paging feature, the PAGE DOWN and PAGE UP UTS 
keys are mapped to the Page Down and Page Up keyboard keys, respectively. 

Paging is most useful where only one screen is available.  Paging provides the means 
to maintain multiple output screen pages for reference while running additional 
transactions. 

WARNING:  The host is completely unaware of the paging feature.  Applications, 
especially DPS, often check the screen input for specific content; meaning the 
application, knowing that a certain screen was displayed, expects the returned data to 
come from that screen.  Use of the Page Down and Page Up keys with this feature can 
leave the screen in a state not expected by the application. 

Also, see Show_Inactive_Page. 

Screen Printer 

The button in this group allows a configured printer in the printer pool to be assigned to one of 
three printer DIDs for the screen. 

Select Printer(s) 

Use this button to assign up to three printers for the screen. 

Print Time-out 

Use this text box to specify how long the emulator will wait for additional print data 
before automatically closing the printer.  The default is 15 seconds. 

-1 (or any negative value) = No timeout, 
0 = Timeout immediately after printing, 
n (any positive number) = Timeout n seconds after printing. 

 



UTS eXpress IT KMSystems, Inc. 

18 11/30/2005 

  

 

Other Settings tab 

The controls on this tab may be used to customize the screen's appearance (color, font, scaling, etc.); 
configure keys and assign keyboards; and design and assign tool bars. 

Select Screen Appearance Scheme 

From this list, select a previously configured (see Custom Appearance, below) appearance 
scheme to be applied to this screen.  Note: This selection only affects the appearance of the 
screen portion of the screen window.  To alter the appearance of the entire UTS eXpress IT 
application, use the Application Scheme button at the bottom of the eXpress IT Configuration 
window (see below). 

Custom Appearance 

Click this button to open the Custom Terminal Screen Appearance  window and configure an 
appearance scheme that may be applied to one or more screens. 

Select Custom Keyboard Layout 

From this list, select a previously configured (see Custom Keyboards, below) keyboard layout 
to be assigned to this screen. 

Custom Keyboards 

Click this button to open the Custom Keyboard Layouts window and configure a keyboard layout 
that may be assigned to one or more screens. 

Macro Manager 

Use this selection to open the Script Manager dialog.  Use the Script Manager to create and 
maintain scripts and script menus. 
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Screen Double-Click Action 

Select an option button from this group to define the action to be taken when you double click 
the mouse button on the emulator screen.  The None option places the text cursor where the 
mouse cursor was double clicked.  Transmit places the text cursor where the mouse cursor 
was double-clicked, but also transmits all information from the cursor position back to the 
previous SOE.   

Screen Right-Click Action 

Select an option button from this group to define the action to be taken when you right click the 
mouse button on the emulator screen.  The None option disables any right mouse click action.  
Menu (the default) presents a popup menu of common selections.   

File Transfer... 

Press this button to configure default drive and path for file transfer. 

Character Translation... 

Press this button to select and edit character translation sets for specific countries. 

Language... 

Click this button to select a single-byte or multi-byte language character set. 

Application Scheme 

Click this button to change the appearance of eXpress application (see Application Color Scheme 
Preferences).  Note: This will not affect the screen appearance.  The screen appearance can be altered 
by clicking the Custom Appearance button on the Appearance and Keyboard tab (see, above). 

Restriction Settings/Configure Settings 

Click this button to toggle to and from the restriction settings dialog. 

Restriction Settings dialog 

The restriction settings dialog on the UTS eXpress IT Configuration window contains configuration 
controls that may be used to enforce configuration security by assigning a configuration password. 

Once the password is assigned, all or selected configuration options may be disabled by checking the 
appropriate option.  Subsequently, to enable an option, you must first unlock the configuration by 
providing the assigned password. 
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Use Configuration Lock Options 

Check this box to initiate password protection on configuration options.  Checking this box will cause 
the Lock Config. Initial Password dialog to be displayed.  After entering and confirming the new 
password, additional security features will become visible (see below). 

Note: For the configuration lock to take effect, both the configuration and the emulator must be exited 
and restarted. 
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With this level of eXpress, users may be restricted to one of three levels: the Power User, the Limited 
User and the Restricted User. 

A Power User may configure all options including connections to the host, thus a Power User has no 
configuration restrictions. 

A Limited User is only limited to configuring non-communications options. 

A Restricted User may be denied any configuration capabilities or limited to only those involving 
application/screen appearance and keyboards. 

eXpress User Capabilities at a Glance 

Allowed Capabilities  
User Level Configure 

Connections 
Terminal 
and 
printer 

Macro 
Development 

Screen 
Appearance 

Customize 
Keyboards 

Application 
Scheme 

Power User Yes Yes Yes Yes Yes Yes 

Limited User No Yes Yes Yes Yes Yes 

Restricted 
User 

No No No Optional Optional Optional 

Settings Location 

The purpose of this feature is to allow all users of a single machine (Windows system) to use the same 
configuration settings for UTS eXpress IT terminal emulator and/or eXpress Connect host connections.  
By default, all emulator settings are saved in files for the current user (C:\Documents and 
Settings\<<USER>>\Application Data\KMSystems\UTS_EXPRESS_IT_4.0\CONFIGURATION) which 
allows multiple users on the same machine to have their own individual settings.   

In some cases, it may be desirable to have one set of configuration settings used by all users of the 
machine.  One reason for common settings is so that the configuration settings can be done once for all 
users, instead of for each individual user; however, users should NOT be allowed to make configuration 



UTS eXpress IT KMSystems, Inc. 

22 11/30/2005 

changes once they are set.  There should only be one allowed to maintain the configuration.  If 
common configuration settings are desired, the emulator settings will be stored in common files 
(C:\Documents and Settings\All Users\Application 
Data\KMSystems\UTS_EXPRESS_IT_4.0\CONFIGURATION) and removed from current user. 

The mechanism for creating common configuration settings in the UTS eXpress IT terminal emulator is 
accessed from this dialog of the UTS eXpress IT Configuration window.  It is accessed from the Edit 
menu in the eXpress Connect Visual Configuration window.  Both the emulator and eXpress 
Connect transport settings are made common or by user, independent of one another.  For example, 
eXpress Connect transport settings may be made common, while emulator settings remain by user. 

The Settings Location feature is only available when Use configuration lock options is checked.  
Again, individual users should NOT be allowed to changes settings when the configuration settings are 
common to all users of the same machine.  

 

  

 

Unlock Configuration 

This button may be used to display the Unlock Config. Password dialog where the proper password 
may be entered to enable the controls on the restrictions dialog.  This button is only visible if the Use 
Configuration Lock Options check box has been set and a password entered. 

Apply 

Click this button to apply the settings immediately without exiting the configuration window.  If you 
have entered the configuration window from the emulator, you will see any changes take effect in the 
emulator immediately. 

OK 

Click this button to accept any changes made in this window and close the window. 
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Cancel 

Click this button to discard any changes made and close the window. 

Terminal Printer Setup 

Use the Terminal Printer Setup window to maintain local printer definitions. In UTS eXpress IT you 
can configure a pool of printers that can be used by UTS eXpress IT screens.  Printers can be 
configured more than once (one for normal Windows printing, one using passthrough printing, one to 
use a different font, one to use a different page orientation, etc.).  You then assign configured printers 
to each screen's printer DIDs as needed.  If no printer is assigned, the Windows default printer will be 
used. 

 

  

 

Add Printer 

Use this button to add a new local printer name and definition.  The name may be any meaningful 
name that uniquely identifies the local printer. 

Setup Printer 

After selecting an existing name from the Available Terminal Printers list box, use this button to edit 
the definition. 

Delete Printer 

After selecting an existing name from the Available Terminal Printers list box, use this button to 
delete the definition. 

OK 

Clicking the OK button saves all changes made in this window and closes the window. 

Cancel 

Clicking the Cancel button closes this window and discards all changes made since it was last opened. 

Help 

Receive on-line help for this window. 
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Printer Device Selection and Setup 

The Printer Device Selection and Setup dialog contains controls to equate an installed printer on 
the PC to a local printer name, use of a local print object, set special UTS print characteristics such as 
passthrough printing or assign Windows print settings. 

 

  

 

Printer Selection 

Controls in this group are used to assign a printer or text file and optionally assign a local print object, 
specify passthrough printing and the print line wrap option. 

Local Printer Name 

The read-only box contains the name of the local printer. 

Use Local Print Object (LPO) 

Check this box to use a user-developed LPO to receive print data instead of standard UTS 
eXpress IT32 print handling.  If this box is checked, the controls in the Standard Printing 
group will be replaced with those in the Local Print Object group. 

See eXpress IT Local Print Objects for the list of methods that may be referenced in the LPO. 

Standard Printing Devices 

The controls in this group will be displayed when the Use Local Print Object check box 
remains unchecked. 
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Selected Printer 

Select a printer from this drop-down list box.  This box contains a list of all printers 
installed through Windows on your PC plus a selection (<text file>) for directing 
printing to a text file on your PC. 

Use Passthrough Printing 

Check this box if the local printer is to be used for passthrough printing (see 
Passthrough Print Settings, below). 

Do Not Wrap Print Lines 

Check this box if long print lines are to be truncated rather than wrapped to the next 
line.  The number of characters that will be truncated or wrapped depends upon the 
font, font style and font size selected for the printer and the page width chosen. 

Local Print Object 

The controls in this group will be visible when the Local Print Object check box is checked. 

Local Print Object Class Name 

In this text box, enter the class name of the registered LPO or press the Browse 
button to search through all OLE Automation Servers registered with Windows. 

User Option 

In this text box, enter any required user options. 

Windows Print Settings 

The controls in this group are available for standard Windows printing (i.e., when the Use 
Passthrough Printing checkbox is not checked). 

Printer Font 

Use these controls to select the font, character set and orientation for standard windows 
printing. 

Font Name 

From this drop-down list box, select an installed font for printing. 

Size 

With this spin box, choose the appropriate font size. 

Bold Face 

Check this box if the print font is to be in boldface type. 

Character Set 

From this drop-down list box, select the desired character set. 

Portrait 

Choose this option to print so that the short edge is the top of the page. 

Landscape 

Choose this option to print so that the long edge is the top of the page. 

Page Header Text 

For normal printing (not passthrough), an option page header can be added.  The heading line 
will only print if text is present. 
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Passthrough Print Settings 

The controls in this group are only available when the Use Passthrough Printing checkbox is 
checked. 

Passthrough printing prints directly to a printer and may be useful in situations where the page 
oriented nature of Windows print management conflicts with the non-page orientation of some older 
TIP applications. 

Whenever possible, you should print using standard Windows print management (the default).  
Windows controls all page formatting based on property settings for a configured print driver on your 
PC.  In this instance, the host application must not send any page control commands (i.e., form feeds) 
to the printer. 

When you bypass Windows print management and print directly to a printer, the host application 
program must supply all page control.  UTS eXpress IT simply passes all information directly through to 
a configured printer. 

Pass-Through Print Options 

The options in this group control special line and form advancement. 

Send LF after CR 

Check this box to tell UTS eXpress IT to use CR LF at the end of a line. 

Send CR after LF 

Check this box to tell UTS eXpress IT to use LF CR at the end of a line. 
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Send CR after FF 

Check this box to tell UTS eXpress IT to use FF CR at the end of a line. 

Send FF on Close 

Check this box to tell UTS eXpress IT to insert a FF at the close of the print. 

Send LF at End of Screen 

Check this box to tell UTS eXpress IT to add an LF at the end of each screen. 

Note: This box should not be checked when using MAPPER AUX because MAPPER 
includes an LF at the end of the screen (you would get one more line).  Send LF at 
End of Screen is for transactions that do not put in an LF, thus causing the next 
screen's data to print starting at the end of the last line. 

Send FF at End of Screen 

Check this box to tell UTS eXpress IT to add a FF at the end of each screen. 

Note: This will send a Form Feed at the end of each screen or block from the host.  If 
the host message does not include an EOMI status, this action is not taken, allowing 
data from multiple screens to be printed without the form feed. 

No Auto-close Print 

Check this box to tell UTS eXpress IT to keep the print open at the end of a print 
operation. 

No Auto Page Feed 

Check this box to tell UTS eXpress IT not to perform a page eject after printing. 

Character Translations 

The entries in this table may be used to specify the ASCII characters that UTS eXpress IT is to 
substitute when receiving special ASCII characters from the host. 

Host Char. 

In this column, enter the decimal representation of the anticipated ASCII host 
character. 

Print Char. 1 through Print Char. 4 

In these columns, enter the decimal representation of the ASCII replacement 
character(s) to be sent to the printer. 

Example of translating the tilde (~) to the Esc character: 

Host Print 

Char Char 1 

126 27 

Note: If additional rows are needed for translation, press the right mouse button over the table 
and select Add Row from the drop-down menu with the left mouse button.  The new row will 
be inserted at the bottom of the table.  The Delete Row item on the drop-down menu may be 
used to delete a selected row. 

Printer Start and End Strings (max 41 chars) 

The entries in this box can be used to provide special starting and ending strings to be sent to 
certain printer devices.  Up to 41 characters may be supplied for each string. 

Start String 

In this row, enter the decimal representations of the ASCII characters to be sent to the 
printer as a beginning string. 

End Scrn Str 

In this row, enter the decimal representation of the ASCII characters to be sent to the 
printer as an ending string at the end of each screen (when no EOMI present).  If the 
End Screen string is present, the Send LF at end of screen and Send FF at end of 
screen are ignored. 

End String 

In this row, enter the decimal representations of the ASCII characters to be sent to the 
printer as an ending string. 
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Import 

Click this button to import an existing passthrough print settings file. 

Export 

Click this button to export the passthrough settings to a file. 

OK 

Clicking the OK button saves all changes made in this window and closes the window. 

Cancel 

Clicking the Cancel button closes this window and discards all changes made since it was last opened. 

Help 

Receive on-line help for this window. 

eXpress IT Local Print Objects 

Local Print Objects (LPOs) are user-written OLE Automation Servers used in place of standard UTS 
eXpress IT32 terminal print handling to provide custom printing capability.  LPOs may be developed in 
any language that supports the development of OLE Automation Servers (e.g., C++, Delphi, etc.). 

LPOs may be developed whenever it is necessary to interpret screen print data in a manner other than 
it is presented on the terminal screen or sent from the host program. 

Local Print Object Interface Specifications 

Local Print Objects must adhere to the following interface specifications: 

LPO_Initialize 

LPO_Initialize is called once just before the first call to LPO_Open.  This method is provided to allow the 
LPO to perform any one-time initialization. 

Format: 

Function LPO_Initialize (Options as Integer) as Integer 

Options is the contents of the User Options entry on the printer device setup configuration.  The LPO 
developer defines the content and use of this parameter.  The emulator does not use or modify it in 
any way. 

The LPO_Initialize function must return the Window Handle of the LPO's main window if successful, or a 
zero if not successful.  A Windows WM_Close message is posted to the LPO's main window using this 
handle when the UTS screen is closed.  This action is done to close the LPO automatically when its 
client UTS screen is closed. 

LPO_Open 

LPO_Open is called whenever the emulator opens the printer. 

Format: 

Function LPO_Open (ScreenRows as Integer, ScreenColumns as Integer) as Integer 

The emulator passes the screen size of the current screen in the ScreenRows and ScreenColumns 
parameters. 

The return value must be a 1 or 0 indicating success or failure, respectively. 

LPO_PrintData 

LPO_PrintData is called whenever the emulator receives a screen print command.  The command can 
come from the host or the keyboard. 

Format: 

Function LPO_PrintData (ScreenData as WideString, ScreenAttributes as WideString,  
CursorRow as Integer, CursorColumn as Integer, Flags as Integer 

ScreenData and ScreenAttributes are passed as WideStrings, but are used as arrays of word (unsigned 
16-bit integers).  
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The ScreenData array contains ALL characters in the screen.  Double-byte characters are ORed with 
100 hex for the lead byte and 200 hex for the trailing byte. 

ScreenAttributes contains the attribute flags associated with the corresponding screen character.  
Attributes are defined as follows: 

The Flags parameter indicates the type of terminal print function requested.  For UTS eXpress IT Flags 
are defined as follows: 0 = Print, 1 = Print Form, 2 = Print Transparent, 4 = Print Screen All. 

The return value must be a 1 or 0 indicating success or failure, respectively. 

LPO_Close 

LPO_Close is called whenever the emulator closed the current print operation. 

Format: 

Function LPO_Close as Integer 

The return value must be a 1 or 0 indicating success or failure, respectively. 

LPO_Show 

The emulator does not currently call LPO_Show. 

Format: 

Function Show (Options as Integer) as Integer 

The Option parameter is not yet defined.   

The return value must be a 1 or 0 indicating success or failure, respectively. 

 

eXpress Custom Terminal Screen Appearance 

The eXpress Custom Terminal Screen Appearance window contains configuration controls to 
change screen fonts and to apply colors to specific areas of the display. 
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Appearance Scheme Name 

From this drop-down list box, select the Color Scheme Name to be altered.  Initially, one color 
scheme, Default, is delivered with UTS eXpress IT.  From the Default color scheme, others may be 
created using the Save As button. 

New Scheme 

Use this button to create a new appearance scheme based on the UTS eXpress IT defaults.  By this 
means, each screen can have its own appearance scheme or screens may share an appearance 
scheme.  To attach an appearance scheme to a screen, see UTS eXpress IT Configuration. 

Note:  The scheme named "Default" may be changed but cannot be deleted.  When a new scheme is 
created or an existing scheme Set to Default (see below), the default values are acquired from 
constants internal to UTS eXpress IT, not from the "Default" scheme mentioned here. 

Rename Scheme 

Click this button to rename an existing appearance scheme. 

Delete Scheme 

Click this button to remove the selected appearance scheme.  Caution:  Any screen attached to the 
deleted scheme will revert to the UTS eXpress IT default scheme. 



KMSystems, Inc. UTS eXpress IT 

11/30/2005 31 

Screen Color Settings 

The Screen Color Settings group contains controls that may be used to change the foreground and 
background color of various UTS screen attributes. 

Select Color for Attribute 

From this group, select an attribute option button whose color is to be changed.  When an 
attribute’s colors are changed, those colors will be applied to all areas of the screen having that 
specific attribute.  An attribute’s colors consist of a foreground (text) color and a background 
color. 

Choose Foreground (text) Color 

To change the text color of an attribute, first select the attribute from the Select Color for 
Attribute option group.  Next, select a color from this drop-down list box.  If you do not wish 
to use one of the standard Windows colors, select Custom at the bottom of the list and 
configure the desired color with the standard Windows Color dialog. 

Choose Background Color 

To change the background color of an attribute, first select the attribute from the Select Color 
for Attribute option group.  Next, select a color from this drop-down list box.  If you do not 
wish to use one of the standard Windows colors, select Custom at the bottom of the list and 
configure the desired color with the standard Windows Color dialog. 

Use UTS60 Colors 

Check this box to use UTS60 colors as set by the host program.  Only valid if the Terminal 
Type selected is UTS60 (select the Terminal Settings tab, press the Configure button and 
edit a route to change the terminal type). 

Always Use Low Intensity for UTS60 Background 

For better contrast, check this box to use low intensity color for UTS60 background color. 

Screen Font 

Use the controls in this group to change the screen font, intensity, size and character set. 

Font Name 

From this drop-down list box, choose the desired font. 

Bold 

Click this button toggle to increase or decrease the intensity of the selected font. 

Font Size 

Use this spin box to increase or decrease the size of the selected font. 

Character Set 

Use this drop-down list box to change the character set. 

Automatic Font Scaling 

These three options control how the emulator will behave when you size a station window or change 
the screen font. 

None 

When the None option is set, no screen or font scaling will be performed when the screen 
window is resized. 

Screen to Font 

The Screen to Font option causes the screen window size to be changed automatically when 
the screen font size is changed.  Consequently, the station window size may be changed 
without altering the size of the font.  If the size of the window is made larger than that 
necessary to accommodate the screen size, a dotted line will show the physical limits of the 
screen.  If the window size is reduced below the physical screen size, scroll bars appear 
allowing access to those parts of the screen not currently visible.   

Font to Screen 

The Font to Screen option causes the font size to change automatically whenever the window 
size of the station is altered.  For example, if a window is enlarged or made smaller, the font 
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will increase or decrease in size, accordingly.  The Font to Screen option will only work when 
using a scalable font (e.g., Courier New, Lucida Sans Typewriter, etc.). 

Default 

Use this button to change the selected color scheme to the UTS eXpress IT defaults. 

Import 

Click this button to import an existing appearance settings file. 

Export 

Click this button to export the appearance settings to a file. 

Apply 

Apply the settings immediately without exiting the configuration window.  If you have entered the 
configuration window from the emulator, you will see any changes take effect in the emulator 
immediately. 

OK 

Click this button to accept any changes made in this window and close the window. 

Cancel 

Click this button to discard any changes made and close the window. 

Help 

Receive on-line help for this window. 

 

eXpress Custom Keyboard Layouts 

This window is used to define which Windows keyboard key or key combination will be used to initiate a 
UTS terminal or UTS eXpress IT emulation specific action or execute an eXpress IT script.  Use this 
window to customize the keyboard to meet your specific needs. 
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New Keyboard 

Click this button to name a new keyboard layout. 

Rename Keyboard 

Click this button to rename an existing keyboard layout. 

Delete Keyboard 

Click this button to delete the selected keyboard layout. 

Graphic Keyboard 

The graphic keyboard display illustrates the configured key or key combinations associated with a 
terminal key.  Note: The location and arrangement of the keys on the graphic keyboard may not match 
the exact layout of your keyboard; however, most keys on your keyboard should have its 
corresponding key represented on the graphic keyboard.  After selecting a key name from the Key 
Actions and Key Sequence Assignment list, the configured key or key combinations will appear as if 
they have been pressed.  You may change (redefine) or add additional key combinations by pressing 
the key(s) on the graphic keyboard with a left mouse click.  Valid key combinations are any single key, 
or a single key plus a combination of one or more of the optional, Shift, Alt and Ctrl keys.  When the 
desired key combinations have been selected, press the Set Key Assignment button to assign the 
key. 

Note:  Pressing the Num Lock key on the actual keyboard will cause the Num Lock display on the 
graphic keyboard to toggle (ON/OFF) and the captions on the faces of the numeric keypad keys to 
change accordingly. 

The extended keys (see below) are not mapped to any key in the Key Actions  list for the default 
keyboard layout file.  They may, however, be mapped by the user to any key or script in the Key 
Actions list.  If they are not mapped, their behavior will be the same as their counterparts on the 
numeric keypad and main keyboard. 
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For enhanced 101- and 102-key keyboards, extended keys are the Ins, Del, Home, End, Page Up, 
Page Down and arrow keys in the clusters to the left of the numeric keypad; and the divide (/) and 
Enter keys in the numeric keypad.  The location and arrangement of extended keys may vary from one 
keyboard to another and may not match the graphic keyboard display. 

Key Actions 

This list box contains the names of all keys and scripts used to control UTS terminal activities or 
activities specific to UTS eXpress IT terminal emulation.  These keys can be mapped to keys pressed on 
the graphic keyboard or via the Type a Key Sequence button. 

Type a Key Sequence 

If this button is clicked, a Type a Key Sequence window will pop up.  In this window, you may type 
the key sequence you desire to map to the currently selected name in the Key Actions list.  On your 
acceptance of the typed key sequence, the key will automatically be mapped. 

Set Key Assignment 

This button sets the mapping of the currently selected Key Action to the selected graphic keyboard 
keys. 

Undefine Key 

This button is used to remove the mapping of a key.  You may remove a mapped key by first selecting 
the key in the Key Actions list followed by a click of this button. 

Default 

This button loads the default keyboard layout as distributed by KMSystems, Inc. 

Import 

Use this button to import an existing keyboard definition file (.KEY). 

Export 

Use this button to save the current keyboard layout to a file. 

Print 

Click this button to print a list of all key actions and key action assignments.  Note: The list will include 
any key sequences assigned to scripts. 

OK 

Clicking the OK button saves all changes made in this window and closes the window. 

Cancel 

Clicking the Cancel button closes this window and discards all changes made since it was last opened. 

How to Map or Re-Map a UTS Terminal or a UTS eXpress IT Key 

The following describes the procedure for re-mapping UTS terminal or UTS eXpress IT keys: 

1) Select the key to be re-mapped from the Key Actions list box. 
2) There are two methods of defining which key or key combination to map to the selected name in the 

Terminal Keyboard Key Names list: 
a) Click the Type Key Sequence button, then type the desired key sequence directly on 

your keyboard.  When you accept the key sequence, the key mapping will automatically 
be set. 

b) Select the desired key from the graphic keyboard using a left mouse click over the face of 
the key.  Next, select the desired Shift, Alt and Ctrl keys, if any, by clicking them with the 
mouse.  Finally, to set the keys selected, click the Set Key Assignment button. 

These steps may be repeated until all desired key mappings are completed. 
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Conflicts 

If a selected key sequence is already mapped to another key, a message box will appear naming the 
mapped Key Actions.  You may then re-map or "undefine" the Key Actions in conflict or choose a 
different key sequence. 

If you map a Key Actions that already has a key sequence assigned to it, a window will appear 
allowing you to Add an alternate key sequence, Redefine (replace) the existing key sequence with the 
new key sequence or Cancel the key assignment operation altogether. 

Add or Redefine Key 

The Add or Redefine Key window appears when a conflict is discovered while attempting to assign a 
keystroke or keystroke combination to a keyboard function. 

Help 

Click this button to receive on help for this window. 

Add 

Click this button to add an alternate key sequence.  This choice is useful when you want more than one 
keyboard key to perform the same function (e.g., the two Enter keys). 

Redefine 

Redefine or replace the existing key sequence. 

Cancel 

Clicking the Cancel button closes this window without assigning the key. 

eXpress IT Macro Manager 

This tab is used to maintain key macros.  Key macros may consist of any UTS key function, standard 
Windows cut/copy/paste, text strings, text strings with user prompts, timed waits and conditional waits 
for strings.  Macros may be created initially within the macro editor or with the macro recorder from 
any open screen. 
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Graphic Keyboard 

The graphic keyboard display illustrates the configured key or key combinations assigned to activate a 
macro.  Note: The location and arrangement of the keys on the graphic keyboard may not match the 
exact layout of your keyboard; however, most keys on your keyboard should have its corresponding 
key represented on the graphic keyboard.  After selecting a macro name from the Available Macros 
list, the configured key or key combinations will appear as if they have been pressed (light gray).  You 
may change (redefine) or add additional key combinations by pressing the key(s) on the graphic 
keyboard with a left mouse click.  Valid key combinations are any single key plus one or more of the 
optional, Shift, Alt and Ctrl keys.  When the desired key combinations have been selected, press the 
Set Assignment button to assign the key. 

Note:  Pressing the Num Lock key on the actual keyboard will cause the Num Lock display on the 
graphic keyboard to toggle (ON/OFF) and the captions on the faces of the numeric keypad keys to 
change accordingly. 

For enhanced 101- and 102-key keyboards, extended keys are the Ins, Del, Home, End, Page Up, 
Page Down and arrow keys in the clusters to the left of the numeric keypad; and the divide (/) and 
Enter keys in the numeric keypad.  The location and arrangement of extended keys may vary from one 
keyboard to another and may not match the graphic keyboard display. 

The extended keys may be mapped to any macro in the Available Macros list.  If they are not 
mapped, their behavior will be the same as their counterparts on the numeric keypad and main 
keyboard. 

Available Macros 

This list box contains the names of all configured key macros.  Each macro can have an activation 
key(s) assigned by pressing the keys on the graphic keyboard, followed by the Set Assignment 
button, or via the Type Sequence button. 
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New Macro 

Click this button to create a new macro.  Hint: You can easily create a new macro by using the macro 
recorder on the UTS eXpress IT emulator window.  See the Start Recorder selection on the Macros 
menu. 

Edit Macro 

After selecting a macro from the Available Macros list, click this button to edit or view the macro with 
the Edit Macro dialog. 

Delete Macro 

After selecting a macro from the Available Macros list, click this button to delete the macro. 

Show in Menu 

Use this button to toggle between placing the selected macro on the Macros menu and removing it 
from view. 

Type Sequence 

If this button is clicked, a Type a Key Sequence window will pop up.  In this window, you may type 
the key sequence you desire to map to the currently selected name in the Available Macros list.  On 
your acceptance of the typed key sequence, the key will automatically be mapped. 

Set Assignment 

This button sets the mapping of the currently selected Available Macros to the selected graphic 
keyboard keys. 

Clear Assignment 

This button is used to remove a key mapping.  You may remove a mapped key by first selecting the 
key in the Available Macros list followed by a click of this button. 

How to Assign a Macro Activation Key 

The following describes the procedure for assigning macro activation keys: 

1) Select the key to be remapped from the Available Macros list box. 
2) There are two methods of defining which key or key combination to map to the selected name in the 

Available Macros list: 
a) Click the Type Sequence button, then type the desired key sequence directly on your 

keyboard.  When you accept the key sequence, the key mapping will automatically be 
set. 

b) Select the desired key from the graphic keyboard using a left mouse click over the face of 
the key.  Next, select the desired Shift, Alt and Ctrl keys, if any, by clicking them with the 
mouse.  Finally, to set the keys selected, click the Set Assignment button. 

These steps may be repeated until all desired activation keys have been assigned. 

Conflicts 

If a selected key sequence is already mapped to another key (macro activation key or terminal 
function), a message box will appear naming the mapped macro or terminal function.  You may then 
re-map or remove the Available Macros in conflict or choose a different key sequence. 

Edit Macro 

The Edit Macro window is used to create and edit a string of successive keystrokes, waits and 
conditions that can comprise a macro. 

 



UTS eXpress IT KMSystems, Inc. 

38 11/30/2005 

  

 

Key Macro Name 

In this text box, enter the name of the macro as it will appear on the Macros menu or macro bar. 

Macro Function List 

This list box contains a serial list of keystrokes, timed waits, prompts and wait conditions that can be 
included in a key macro.  Select from this list when replacing, deleting or moving a function in the list. 

Add 

Click this button to reveal a drop-down menu containing six different types of functions that may be 
included in the macro. 

Terminal Key Function 

Make this selection to bring up the Select Terminal Key Function window where a single UTS or 
UTS eXpress IT terminal keystroke (e.g., SOE, XMIT, CLIPBOARD_COPY, etc.) may be selected. 

Text String 

Make this selection to initiate the Text String dialog used to enter a string of text in the macro. 

Text String Prompt 

Use this selection to place a user prompt dialog in the macro.  The selection displays the Edit 
Prompt for Text window where a user prompt string may be entered.  When the macro is run, 
the dialog will be displayed with the user prompt, querying the user to enter a text string.  

Cursor Position 

Use this selection to place the cursor at a particular row and column.  This selection displays the 
Position Cursor dialog where the row and column may be entered. 
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Timed Wait 

Make this selection to specify that the macro should wait for a period of time.  The selection 
displays the Timed Wait window where the pause time is specified in seconds. 

Wait for String 

Select this item to insert a conditional wait in the macro.  The ensuing Wait for String dialog 
allows you to specify a search string, the location of the search string on the screen, an equal or 
not equal operator and a timed wait value. 

Replace 

After selecting a function from the Macro Function List box, click this button to replace the function 
with a different function, or edit the selected function.  This button drops down the same selection 
menu as described for the Add button (see above). 

Delete 

After selecting a function from the Macro Function List box, click this button to delete the function 
from the macro. 

Move Up 

Press this button to move the selected function up in the macro. 

Move Down 

Press this button to move the selected function down in the macro. 

Revert 

Clicking this button will revert any changes to the macro since the dialog was opened. 

OK 

Click this button to accept the changes to the macro and close the window. 

Cancel 

Click this button to discard any changes and close the window. 

Edit Prompt for Text 

This window allows a user prompt to be entered and placed in the macro. 

Enter User Prompt 

In this text box, enter the prompt to be displayed when the user is asked to enter a text string. 

Password Entry 

Check this box to password protect the text entered by the user.  Password protection causes asterisks 
(*) to be displayed in the text box as the user enters the text string. 

OK 

Click this button to accept the entries and close the window. 

Cancel 

Click this button to discard the entries and close the window. 

Position Cursor 

This window allows you to position the cursor to a location on the screen. 

Column 

In this text box, enter the column to place the cursor. 



UTS eXpress IT KMSystems, Inc. 

40 11/30/2005 

Row 

In this text box, enter the row to place the cursor. 

OK 

Click this button to accept the entries and close the window. 

Cancel 

Click this button to discard the entries and close the window. 

Select Terminal Key Function 

This window allows the entry of single UTS terminal key or UTS eXpress IT key functions into the script. 

Type List Search String 

In this text box, enter a partial or full terminal key function name.  Type only enough of the name to 
highlight the desired key function in the key function list box below this list box. 

OK 

Click this button to select the highlighted key function. 

Cancel 

Click this button to cancel the selection process. 

Text String 

This window allows the macro developer to enter a string of text in the macro. 

Enter a Text String 

In this text box enter the text string.  The string of text will be inserted at the current cursor position 
on the screen. 

OK 

Click this button to accept the text entry and close the window. 

Cancel 

Click this button to discard the entry and close the window. 

Timed Wait 

This window allows the entry of a pause in the execution of the macro.  The timed wait is useful when 
communications is slow and a large amount of processing from the host occurs before returning control 
to the terminal screen. 

Enter Wait Time in Seconds 

In this text box, enter the number of seconds the macro is to wait before resuming processing of the 
next macro function. 

OK 

Click this button to accept the entry and close the window. 

Cancel 

Click this button to discard the entry and close the window. 

Wait for String 

This window allows a conditional wait to be placed in the macro.  The macro will wait for the presence 
or absence of a string returned from the host. 
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String Value 

In this text box, enter the string to look for on the screen.  The value entered is case insensitive. 

String Location 

This group allows the location on the screen of the anticipated text string. 

When choosing the location on the screen to test for a string, you should be aware of the sequence of 
events that occurs, before the macro gets control to do the testing.  For example, in DEMAND mode, 
most output received from the host is painted on the next to last line of the terminal display.  Before 
control is returned to the macro, a CURSOR TO HOME and DELETE LINE is issued, thus moving the 
output to two lines from the bottom of the display.  Thus, on a 24-line display, testing should be 
performed on row 22, not row 23. 

Row 

In this text box, specify the row where the beginning of the string is expected. 

Relative to Current Row 

If this box is checked, the value entered in the Row text box is relative to the current row of 
the cursor. 

Column 

In this text box, specify the column where the beginning of the string is expected. 

Relative to Current Column 

If this box is checked, the value entered in the Column text box is relative to the current 
column of the cursor. 

Any position in Entire Screen 

Check this box to look for the string beginning at any position on the screen. 

Wait for String To Be 

This option group is used to specify if the condition checked for is true or false. 

Equal = 

Select this option to check for an equal condition. 

Not Equal <> 

Select this option to check for a not equal condition. 

Wait Time (seconds) 

In this text box, enter the number of seconds to wait before failing the test.  In other words, this is the 
interval of time to wait for the presence (=) or absence (<>) of the anticipated string.  When this time 
is exceeded, a time-out message box will appear during macro execution. 

OK 

Click this button to accept the entries and close the window. 

Cancel 

Click this button to discard the entries and close the window. 

 

File Transfer Defaults 

The File Transfer Defaults window contains controls allowing the selection of default PC paths to be 
used when performing host/PC-initiated file transfers to or from the host. 
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See also, Line Input # Statement for an upload example and GetScreenLine Function for a PC-initiated 
download example. 

Send File Path 

This information box contains the default drive and path for PC files to be transferred to the host.  Use 
the Select button to the right of this box to change the default drive and path. 

Select 

Click this button to initiate the Select Directory dialog where the Send File Path may be changed. 

Receive File Path 

This information box contains the default drive and path for PC files to be transferred from the host.  
Use the Select button to the right of this box to change the default drive and path. 

Select 

Click this button to initiate the Select Directory dialog where the Receive File Path may be changed. 

Override Drive Letter with Drive Selected by Host 

Check this box if the host program will be allowed to change a default drive specification. 

OK 

Clicking the OK button saves all changes made in this window and closes the window. 

Cancel 

Clicking the Cancel button closes this window and discards all changes made since it was last opened. 

Help 

Receive on-line help for this window. 

 

Select Directory 

Use this dialog to select the default drive from the Drives drop-down list box and the default directory 
or directories from the Directories list box. 

UTS Character Translation Configuration 

The UTS Character Translation Configuration window provides the ability to select and edit 
character translation sets for specific countries. 
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Select the translation set (the default is NO TRANSLATION) for your locality. 

To add a translation set, click the Add button.  A second window will appear where you may enter a 
country name that will correspond to the translation set. 

To change one or more characters in a translation set, highlight a country name using the left mouse 
button or the up/down arrow keys and click the Edit button. 

To delete a translation set, highlight a country name using the left mouse button or the up/down arrow 
keys and click the Delete button. 

Import 

Use this button to import an existing character translation file (.ini). 

Export 

Use this button to save the current character translation to a file. 

OK 

Clicking the OK button saves all changes made in this window and closes the window. 

Cancel 

Clicking the Cancel button closes this window and discards all changes made since it was last opened. 

Character Translation Edit 

This window allows you to specify host character and local character pairs for translation on all data 
received from, or sent to, the host during a UTS eXpress IT session.  All characters are specified in 
ASCII numeric notation. 
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Select an existing character in the translation table using the scroll bar, mouse and/or up/down arrow 
keys.  Type any changes into the two text boxes (Host and Local) at the bottom of the window. 

To add a new character, select each of the two text boxes (Host and Local) at the bottom of the 
window, enter the new values and click the Add button. 

To delete an existing character, select a character in the translation table using the scroll bar, mouse 
and/or up/down arrow keys and click the Delete button. 

OK 

Clicking the OK button saves all changes made in this window and closes the window. 

Cancel 

Clicking the Cancel button closes this window and discards all changes made since it was last opened. 

Language Type 

This window allows you to select a single-byte or multi-byte language type. 

Select Language Type 

From this drop-down list box, select from Latin (default) or other multi-byte language types. 

OK 

Clicking the OK button saves all changes made in this window and closes the window. 

Cancel 

Clicking the Cancel button closes this window and discards all changes made since it was last opened. 

Application Color Scheme Preferences 

The Application Color Scheme Preferences window contains controls that affect the appearance of 
the eXpress application.   
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Selection on this window does not affect the appearance of the screen portion of an opened session.  
Unlike color selections set for emulation screens, application colors will be affected by any changes that 
have been made to the Windows System Colors. 

 

  

 

Schemes 

From the drop-down list box, select from one of the pre-configured schemes from KMSystems or from 
a scheme created by you.  The pre-configured schemes marked as, "(Preset)", may not be altered but 
may be selected and become the basis of a new scheme created by you (see the New Scheme button. 

New Scheme 

Click this button to create (name) a new application scheme.  Note: Whatever scheme is 
selected from the drop-down list box will be the basis of the new scheme. 

Rename Scheme 

Click this button to rename a selected scheme.  "(Preset)" schemes may not be renamed. 

Delete Scheme 

Click this button to delete a selected scheme.  "(Preset)" schemes may not be deleted. 

Button Effects 

The controls in this group determine the appearance of buttons on the eXpress application. 

Select Button Color Effects 

Use the buttons in this group in conjunction with the Select Color button to change the colors 
of buttons and the colors displayed on mouse flyover. 
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Normal Background 

Click this button followed by the Select Color button to change the background color 
of non-selected buttons. 

Normal Text 

Click this button followed by the Select Color button to change the color of text on 
non-selected buttons. 

Normal Border 

Click this button followed by the Select Color button to change the color of the border 
surrounding non-selected buttons. 

Flyover Background 

Click this button followed by the Select Color button to change the background color 
of buttons when the mouse cursor is moved over the button. 

Flyover Text 

Click this button followed by the Select Color button to change the text color that will 
appear when the mouse cursor is moved over a button. 

Flyover Border 

Click this button followed by the Select Color button to change the border color that 
will appear when the mouse cursor is moved over a button. 

Selected Background 

Click this button followed by the Select Color button to change background color of a 
selected button. 

Selected Text 

Click this button followed by the Select Color button to change the text color of a 
selected button. 

Selected Border 

Click this button followed by the Select Color button to change the border color of a 
selected button. 

Flyover Sel Background 

Click this button followed by the Select Color button to change the background color 
of a selected button when the mouse cursor is moved over the button. 

Flyover Sel Text 

Click this button followed by the Select Color button to change the text color of a 
selected button when the mouse cursor is moved over the button 

Flyover Sel Border 

Click this button followed by the Select Color button to change the border color of a 
selected button when the mouse cursor is moved over the button 

Select Color 

Use this button to change color after selecting a button effect from the Select Button Color 
Effects button group. 

Use Standard Windows Look 

Standard look will make buttons and panel look like the standard windows controls.  If XP 
themes are in uses, buttons will have themes applied.   

Note: When this box is checked, changes made using other color controls on this dialog will not 
be evident in the eXpress application; i.e., checking this box overrides all other color selections 
for the application.  Screen color selections are unaffected by this option. 

Use 3d Button Effect 

If this box is checked, all buttons will have a three-dimensional appearance.  If the box is not 
checked, buttons will have a flat appearance. 
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Form Color Preview 

All controls in this group are for preview purposes only. 

Panel Title Text 

The background and text in this title are affected by selections made with the Panel Title 
Color and Panel Title Text Color buttons in the Window Effects group at the bottom of this 
dialog. 

Sample Button 

The appearance of this button can be altered by any of the controls in the Button 
Effects group to the left of this preview panel. 

Sample Selected 

When this box is checked, the Sample Button will appear as determined by the 
bottom six buttons in the Select Button Color Effects; unchecked, the top six 
determine the effect. 

Panel Text 

Panel text and panel background are set using the Panel Text Color and Panel Color 
buttons, respectively. 

Window Effects 

The six buttons in this group let you set the color scheme for the windows, panels and text displayed in 
the eXpress application.  For button colors, see above. 

Window Color 

This button determines the background color of the eXpress windows. 

Window Text Color 

This button determines the color of any text appearing on an eXpress window.  It does not 
affect panel or button text. 

Panel Color 

Use this button to alter the background color of a panel. 

Panel Text Color 

Use this button to change any text found on a panel. 

Panel Title Color 

This button may be used to alter the background color of panel titles. 

Panel Title Text Color 

Use this button to alter the text color of panel titles. 

Set to Defaults 

This button may be used to reset button and window color defaults according to the way they are 
defined in Windows. 

Apply 

Use this button to apply any changes immediately without exiting this window. 

OK 

Use this button to accept changes and exit the window. 

Cancel 

Use this button to reject any changes and exit the window. 
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Application Color Selector 

The color selections on this window are divided into three groups: A basic 40-color set, the standard 
Windows 27 System Colors and a custom color area for gradient color selection.  There is also a list box 
of System Colors by Name for selection. 

Note: System Colors changed from the Windows Control Panel will affect the System Colors made 
available on this window. 

 

 

 

Std. Color Dialog 

Click this button to use the traditional Color dialog for selection. 

Apply 

Click this button to apply any changes without exiting the selection dialog. 

OK 

Click this button to accept any changes and exit the window. 

Cancel 

Click this button to discard any changes and exit the window. 

Lock Config Initial Password 

This dialog is used to supply an initial password that will be required to access the restriction controls.  
This dialog appears because of the Use Configuration Lock check box being set on the UTS eXpress 
IT Configuration dialog (click the Restriction Settings button). 

New Password 

Enter a 1-8-character password.  All keyboard characters are allowed. 

Reenter New Password to Confirm 

Reenter the same password in order to confirm the entry.  This entry is required when the New 
Password entry is specified. 

OK 

Press this button to accept the entries on this dialog and continue. 
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Cancel 

Press this button to cancel any entries made on this dialog. 

Unlock Config Password 

This dialog is used to supply the password that will enable the restriction controls.  The dialog may also 
be used to change an existing password. 

Enter Password 

Enter the password required to unlock (enable) the restriction controls. 

New Password 

To change the password, enter the new password in this box.  This entry is optional. 

Reenter New Password to Confirm 

Reenter the same password in order to confirm the entry.  This entry is required when the New 
Password entry is specified. 

OK 

Press this button to accept the entries on this dialog and continue. 

Cancel 

Press this button to cancel any entries made on this dialog. 

UTS eXpress IT Settings 

This dialog is used to switch the location of the UTS eXpress IT configuration settings.  The settings 
may be stored in such a manner as to allow multiple users of a single Windows system to maintain 
their individual configurations.  When individual configurations are to be maintained (the default), the 
settings are placed under C:\Documents and Settings\<This User>\Application Data.  On the other 
hand, if it is desirable for all users of the system to use the same configuration, an option is available 
to move those settings to the common location, C:\Documents and Settings\All Users\Application Data. 

Note: "<This User>" will be the user-id used to log on to Windows. 
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The dialog acts as a toggle between <This User> and All Users; i.e., if your settings are currently 
stored in <This User>, the message will indicate that they be moved to All Users; if they are in All 
Users, the move would be to <This User>. 

Delete Source Settings 

Check this box to delete the settings in their former location.  If this box is not checked, the settings 
will remain in their old location but will NOT be used or updated in any way. 

Set 

After selecting an option above, click this button to complete the move. 

Cancel 

Press this button to ignore any selections and return to the previous dialog. 
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How to ... 

Selecting with the Mouse 

All selections discussed in this section are made with a single click of the left mouse button.  For 
example, the instruction, "select Print Screen (All) from the File menu," implies that the following 
actions should be taken: 

1. Move the mouse cursor over the word, File, on the menu bar. 

2. Click the left mouse button once to reveal the menu. 

3. Move the mouse cursor over the Print Screen (All) selection. 

4. Press the left mouse button again to complete the instruction. 

Note: Left and right, mouse button actions may be reversed (run the Mouse icon/program in the 
Windows Control Panel). 

If configured, a right mouse click over any portion of the screen will drop down an edit menu of 
frequently used commands. 

Where appropriate, shortcut keys are shown in parentheses on menu selections. 

Running without the Control Panel 

You may run UTS eXpress IT without the control panel being visible using the NCP command line option 
as follows: 

"c:\Program Files\KMSystems\UTSPlus32\4.0\UTSPlus32.exe" NCP 

To run with the NCP option, you must first run without it and configure at least one screen to 
automatically open at start-up.  To configure: 

1. Start UTS eXpress IT without the NCP option. 

2. Click the Configure UTS eXpress IT  button on the control panel. 

3. Select and configure a screen as desired. 

4. Check the Open Screen on Start-up 

5. Repeat Steps 3 and 4 if additional screens are required. 

6. Click the OK button. 

7. Click the Exit  button on the control panel. 

Finally, add the NCP command line option to the Target entry of the UTS eXpress IT shortcut as 
follows: 

1. Right click on the UTS eXpress IT icon.  From the Windows Task Bar, this icon is on the 
Start | Programs | UTS eXpress IT menu selection. 

2. Select Properties. 

3. Change the Target entry. 

Note: When all screens are closed by the user, UTS eXpress IT will automatically exit. 

Configuring UTS Keys 

To change a UTS key, follow this procedure: 

1. Click the Configure button  on the UTS eXpress IT Control Panel.  

2. After selecting a screen tab, press the Custom Keyboards button 

 on the Appearance and Keyboard tab.  The eXpress 
Custom Keyboard Layouts window will appear. 

3. Select the keyboard layout you wish to configure from the Keyboard Name drop-down list 
box, or a new layout using the New Keyboard button to the right.  Note: Layouts are 
related via a named keyboard and associated with a particular screen on the Appearance 
and Keyboards tab.  In this manner, it is possible for each configured screen to have its 
own unique keyboard layout or share a layout with other screens. 
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4. Select a key from the UTS Terminal Keyboard Key Names list box. 

5. Press the desired key or key combination (any key plus Alt, Ctrl and/or Shift) on the 
visual keyboard. 

6. Press the Set key assignment button. 

7. If a key is already defined, a message window will appear allowing you to replace 
(Redefine) the existing definition or Add an additional definition. 

8. Press the OK button on the eXpress Custom Keyboard Layouts window. 

9. Repeat steps 2 through 8 for each screen desired. 

10. Press the OK button on the UTS eXpress IT Configuration window. 

Using Mapper "Look and Feel" 

A useful option of UTS eXpress IT is the Mapper "Look and Feel" feature.  In general, this feature 
provides a graphical look to the Mapper user and gives function key capability when using the mouse.  
The Mapper "Look and Feel" feature was first implemented in Mapper level 35, but is not limited to 
Mapper users only.  The feature may also be useful in any host application that supports the feature 
(e.g., DPS applications).  To use the Mapper "Look and Feel" feature, follow this procedure: 

1. Click the Configure button  on the UTS eXpress IT Control Panel.  

2. After selecting the desired screen, set the Mapper look check box on the Terminal 
Settings tab. 

3. Press the OK button. 

For more on the display characteristics and restrictions of Mapper "Look and Fe see Mapper Look. 

Applying Colors and Fonts to Specific Screens 

You may change the appearance of the text displayed on a UTS eXpress IT screen by selecting from a 
list of screen fonts installed on your system.  Colors may be applied based on field attributes displayed 
on the screen.  To change the screen’s font and or color, follow this procedure: 

1. Click the Configure button  on the UTS eXpress IT Control Panel.  

2. After selecting a screen tab, click the Custom Appearance button 

 on the Appearance and Keyboard tab. 

3. Select a scheme name from the Appearance Scheme Name drop-down list box or press 
the New Scheme button and name a new scheme.  Note: Colors and fonts are related via 
a scheme name and associated with a particular screen on the Appearance and 
Keyboard tab.  In this manner, it is possible for each configured screen to have its own 
unique font and color scheme or share a scheme with other screens. 

4. Select the desired font and font sty with the controls at the bottom of the window in the 
Screen Font group. 

5. For color changes, select a field attribute from the option buttons in the Select Color for 
Attribute option group.  Note: If the terminal type chosen is UTS60, the colors may only 
be set by host application software (e.g., MAPPER, DPS, etc.). 

6. Next, select the foreground (text) and background colors from the two drop-down list 
boxes provided. 

7. Repeat Steps 5 and 6 for each attribute required by your host application. 

8. From the Select Screen Appearance Scheme drop-down list box, select the custom 
appearance scheme. 

9. Repeat Steps 2 through 8 for each screen desired. 

10. Press the OK button on the UTS eXpress IT Configuration window. 

Changing Screen Dimensions 

The default dimensions of a UTS eXpress IT screen is 24 rows by 80 columns.  If a host application 
supports a different size (e.g., 49x80, 24x132, etc.), you may change the dimensions with the 
following procedure: 
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1. Click the Configure button  on the UTS eXpress IT Control Panel.  

2. After selecting the desired screen tab, click the Configure Routes button. 

3. On the eXpress Connect Visual Configuration window, double-click the selected route. 

4. Change the Rows and Columns as required. 

5. Press the OK buttons repeatedly to exit the configuration process and return to the 
emulator. 

Note:  If a screen is open when the above change is made, it must be closed and reopened for the 
dimension change to take effect. 

Recall Recent Input 

On occasion, you may wish to recall or retransmit a line of input to the host, and that line, no longer 
appears on the screen.  From one execution of UTS eXpress IT to another, eXpress retains a list of the 
200 most recent lines sent to the host.  The following procedure outlines the steps required to use this 
feature: 

1. Position the cursor at the point on the screen where you wish the line to be repainted. 

2. Press Ctrl+Up Arrow (this key is configurable, see Configuring UTS Keys) or select Input 
Recall from the Edit menu. 

3. With the mouse, select the desired line from the list box provided. 

4. Click the Transmit button to paint the line and transmit it to the host (double-clicking the 
line will also cause a transmit).  If you wish to alter the line before transmitting, click on 
the Paste button. 

Note:  This feature is particularly useful when the recall line is lengthy and you wish to avoid having to 
retype the entire line. 

Using UTS Function Keys 

Many host applications support the use of UTS function keys.  UTS eXpress IT supports all 22 function 
keys (F1 through F22) that may be selected traditionally from the keyboard or with the mouse using 
buttons on a tool bar.  To display the default tool bar, select the Show Tool Bar toggle on the View 
menu. 

Note: A button is also provided for the standard UTS Message Wait (MsgWait) and Key Unlock 
(Unlock) functions. 

Displaying UTS eXpress IT Keyboard Definitions 

At times, you may wish to perform standard UTS terminal functions through the keyboard such as 
ERASE TO END FIELD, TAB BACK, etc.  An easy way to see the keyboard key sequences required to 
perform these UTS terminal functions is through the display of the UTS eXpress IT Keyboard 
Definition window.  To view this window, select Show Keyboard Help Window from the View 
menu. 

Execute any key (UTS key or Keyboard Key Sequence) in the window’s list box by double clicking on 
it, or leave the window displayed as a reference to key sequences required from the keyboard.   

With the UTS eXpress IT Keyboard Definition window displayed, you may reposition the cursor with 
two left mouse clicks anywhere in a UTS eXpress IT screen. 

To keep the UTS eXpress IT Keyboard Definition window completely visible while working on a UTS 
eXpress IT screen, check the Stay on top box. 

Assign Printers to Screens 

UTS eXpress IT allows you to assign printer definitions to individual screens.  Here are some of the 
benefits: 

• You can configure the same printer many times with different fonts and/or orientation. 

• You can give each configured UTS Printer a meaningful name like "Lexmark 9pt Portrait," 
"Lexmark Landscape" or "HP Passthru mode". 

• Each screen can have different printers.  Each DID, for each screen, can be a different printer. 

• If a printer is not assigned at run-time, the current Windows default printer is used. 

To assign a printer to a screen that is already opened, follow this procedure: 
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1. Select Printer Assignment from the File menu and proceed to Step 3, below. 

To assign a printer to a screen from the UTS eXpress IT Configuration menu: 

1. Select the appropriate Screen tab. 

2. Click on the Select Printers button on the Terminal Settings tab. 

3. Press the Select button for the desired DID. 

4. If the printer was previously configured, select it from the Available Terminal Printers 
list box, click on the OK button and skip to Step 9. 

5. To add a new local printer, press the Add Printer button. 

6. Enter any meaningful name and click the OK button. 

7. From the Selected Printer drop-down list box, select the installed printer that you want to 
link to the Local Printer Name.  Note: If the desired printer is not in the list box, you will 
need to install it with Windows (Start, Settings, Printers from the Windows active task 
bar and the Add Printer icon). 

8. Set other options desired (font, passthrough, etc.) on the three tabs and press the OK 
button to assign the printer. 

9. Click the OK buttons on each of the successive UTS eXpress IT dialogs to complete the 
process. 

Printing 

There are two forms of printing available in UTS eXpress IT: Printing an exact image of the entire 
screen and UTS screen-printing (printing from the most recent SOE to the cursor). 

To print an exact screen image, follow this procedure: 

1. Select Print Screen (All) from the File menu (or Ctrl+P) or by using the corresponding 
button on the tool bar. 

To use the UTS screen-printing feature, follow this procedure: 

1. Select Print Screen (UTS) from the File menu (or Ctrl+U). 

2. Return to the host session and perform any host printing tasks (@@PRNT, MAPPER AUX 
printing, etc.). 

Note:  The Ctrl+P and Ctrl+U are the default key combinations used for printing with UTS eXpress IT; 
however, both may be reconfigured to other keys or key combinations (see UTS keyboard key 
settings). 

 

Printing to a File 

To print to a file, you need to set up a pseudo-printer that will direct the print output to a file.  You may 
set this pseudo-printer from two places: 1) from the emulator screens' File, Print Assignment menu 
selection or 2) by pressing the Assign Printers button on the Terminal Settings tab of the UTS 
eXpress IT Configuration dialog.  Note: In either case, the printer, or in this case file, must always 
be associated with a particular configured screen. 

To assign the print file from the emulator screen, follow these steps: 

1) Select Printer Assignment… from the File menu. 
2) Go to Step 5, below. 

To assign the print file from the UTS eXpress IT Configuration dialog: 

3) Click the desired Screen tab. 
4) Click the Select Printers button. 
5) Click the Select button for one of the three printer devices available on the Screen Printer Device 

Assignments window.  Note: If the print output is from selecting one of the Print Screen controls from 
the emulator's File menu, then Printer Device 1 (DID1) must be used. 

6) Click the Add Printer button on the Terminal Printer Setup dialog and enter a unique local name. 
7) On the Printer Device Selection and Setup dialog, select "<Text file>" from the Selected Printer drop-

down list box. 
8) Press the OK button on all dialogs until you are back to your original starting point. 

The print sequence may now be initiated from whichever screen has the print file assigned.  When the 
print action begins, you will be solicited for the file name. 
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Miscellaneous 

Command Line Options 

The following are the UTS command line options.  They are NOT case sensitive and are separated by 
spaces: 

NL  = No Logo (Splash Screen) 

NCP = No Control Panel 

SMAX = Show Screens Maximized 

TRANSTRACE = Transport Trace On Start   

MULTI_INST = Allow multiple instances of program 

Font Limitations 

The ability to increase/decrease font size by a single point only works properly when using scalable 
fonts like the True Type font, Courier New (installed with Windows).  Non-scalable fonts have a fixed 
number of point sizes available (e.g., 6, 9, 11, 14, etc.) and are missing several point sizes (e.g., 7, 8, 
10, 12, 13).  Consequently, UTS eXpress IT will be unable to increment/decrement to the missing 
sizes.  To select a different font, follow this procedure: 

1. Click on the Configure button  on the UTS eXpress IT Control Panel.  

2. After selecting the desired screen tab, select the Appearance and Keyboard tab. 

3. Click the Custom Appearance button. 

4. Select the font and font style desired from the controls in the Screen Font group at the 
bottom of the window. 

5. Press the OK button. 

Note: All of the True Type fonts are scalable. 

Technical Support 

If you are experiencing difficulties configuring UTS eXpress IT and need assistance, please contact the 
person responsible for maintaining UTS eXpress IT at your site.  If you are having trouble connecting to 
a host mainframe, please consult the person(s) responsible for maintaining communications at your 
site.  If difficulties persist, you may reach the Technical Support Group at KMSystems, Inc., through 
one of the following: 

Internet E-mail Support – support@kmsys.com 
Telephone Support – (770) 635-6363  

Web Site – www.kmsys.com 
Main Number – (770) 635-6350 

Facsimile – (770) 635-6351 

 

mailto:support@kmsys.com
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